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QUICK START

DevCom2000 uses Device Descriptions (DDs) to access data stored in the memory of the smart field device. These
DDs are developed by the manufacturer for their products and, in turn, distributed by the HART® Communication
Foundation (HCF) worldwide. The latest DDs are included as part of the DevCom?2000 installation. Visit the HCF
website (www.hartcomm.org) or the ProComSol website (www.procomsol.com) for update information.

The following steps will allow you to install and quickly begin using DevCom?2000:

Step 1: Install the DevCom2000 application

Insert the DevCom?2000 installation CD into the CD drive on your computer. The DevCom?2000 installation will
automatically start and guide you through the installation process. Install DevCom2000 in its default location. If
the installation program does not begin automatically, please go to Start->Run—> and enter “CDRom drive
letter”:\DevCom?2000Setup.exe. This will begin the installation program.

Step 2: Connect the communication interface

Connecting to a HART device requires special interface hardware to be attached to your computer. These
interfaces ("HART Modems") are available from ProComSol, Ltd and other sources. The interface should be
connected and configured. Note: Many USB to RS232 converters will not work with the HART protocol. Due to
concerns about port replicators it may be necessary for you use a USB to HART modem (ProComSol, Ltd model
HM-USB-ISO) if you do not have an RS232 port.

Step 3: Connect to the field device

Find a connection point for the device’s 2-wire 4-20mA loop you wish to communicate with. For communications
you must have a suitable load resistance or a 250€2 resistor must be placed in series with the device. Using the clips
from the HART interface, connect to the HART device. While the HART Communication signal is available
anywhere along the 4-20mA wiring, it is often easiest to connect across the field device's terminals (caution should
be observed when working in a hazardous area, many PC’s are not rated for intrinsic safety and should only be
connected in a safe area).

Step 4: Activate DevCom2000

Launch DevCom?2000 by selecting the DevCom2000 icon on your desktop. You can also start the application by
going to your computer's Start Menu and selecting Start = Programs = ProComSol - DevCom2000 -
DevCom2000 to launch the program.

You will now be asked to Activate DevCom2000. If you have Activation Codes (located on the CD case), select
the Activation method of your choice (Manual or Online). Select the Evaluate option if you do not have Activation
Codes. You can use DevCom?2000 for 10 days before you need to Activate it.

If you are Activating DevCom2000 by the online method, select online activation. You will be asked to enter the
Activation Codes on the next screen. Once entered, DevCom2000 will connect to the Internet to verify the
Activation Codes. If you do not have an internet connection, you can activate it by email or phone using the
Manual Activation method. Activation details are fully explained later in this manual.

Activation only needs to occur once.
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Step 5: Set the DevCom2000 Serial Port

DevCom?2000 uses a default serial port of COM99. The serial port should be changed from Options = Basic on
the DevCom2000 menu to the appropriate serial port for the HART Modem. The other settings on the Options tabs
typically do not need to be changed.

Step 6: Browse the Device

Operating DevCom2000 is similar to working with Windows® Explorer. DevCom2000 communicates to the field
device, establishes a connection and learns its identity. Once DevCom2000 knows its identity, DevCom2000
locates the device's DD and loads it. From this point forward operation of DevCom2000 is determined by the DD
provided by the product's manufacturer. If a DD for the device is not present, a generic DD will be used.

By default, DevCom2000 will open the Browser window. The organization of the data in this explorer-style
window is dictated by the device DD. The left hand tree-pane of this window shows the logical groups of field
device data. These are called "Menus". The right hand data-pane shows the data, any sub-groups and any standard
operating procedures found on a given menu.

You can browse through the field device data by expanding (click "+" symbol) or collapsing (click the "-"
the menus in the tree-pane. You can also double-click the folder symbol when seen on the data-pane.

symbol)

Step 7: Modify the Device's Configuration

The Browser allows access to all of the data exactly as described by the product's manufacturer’s DD. When you
find elements of the field device's configuration you want to change, simply double-click and edit the data. Once

you have changed the configuration to suit your needs, press the Send icon B to commit the data and transfer it to
the field device.

Step 8: Performing Maintenance and Testing the Field Device

Many devices perform Methods or Standard Operating Procedures (SOPs) that may need to be performed to ensure
the device is in peak condition. These Methods may include calibrating the loop current, trimming the transducer
values or performing some diagnostic test on the field device. Methods appear in the data-pane just like data does.
Double-click on the Method and it will start running in a separate window. The Method will guide you through the
process ensuring the procedure is completely and consistently performed. When the Method is complete the
window will disappear.

Step 9: Exit
When you are through working on the field device simply exit DevCom2000. Once the program exits, you can
then disconnect the HART interface hardware.
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1 INTRODUCTION

The Smart Device Communicator (DevCom2000) allows access to and management of a HART compatible field
device's configuration and calibration. This manual provides the information about the Hardware setup,
Communication with Smart devices, and functions of DevCom?2000.

DevCom2000 is unique in that it uses the DD of the connected device to determine what information to display,
what variables are available for edit, and what procedures to follow for calibration, setup, and maintenance.

1.1 Acronyms and Definitions

Acronym Definition

COTS Commercial-off-the-Shelf

DD Device Description File. This contains the device
information.

DDL Device Description Language

HCF HART Communication Foundation

DevCom2000 Smart Device Communicator Software

1.2 Conventions Used in This Manual
Following formatting conventions are used in this guide:

Convention Description

Words in bold type Field names including buttons in the display,
or important phrases.

- Arrow Windows pull down menus and their options
are separated by >

For example, click Device - New Device to
connect to a new device.

Courier font Information that you type, parts of the code
quoted for explanations or as examples.
UPPERCASE Acronyms
UPPERCASE within Command keys
angle brackets For example, press <KENTER>.
MAN-1010 05/01/2014 Our Quality Management System is Page 5
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1.3 Document Organization
DevCom2000 user manual is organized into the following sections:

Section 1

Section 2

Section 3

Section 4

Section 5

Section 6

Describes the scope and objective of DevCom?2000 user
manual along with the organization of the remaining part of
the manual.

Provides an overview of the DevCom2000 application and
its architecture.

Provides the information pertaining to hardware and
software requirements for the DevCom2000 application.

Provides the steps to install, activate, and uninstall the
DevCom2000 application.

Provides the steps to start the DevCom2000 application and
connecting to field devices.

This section explains different aspects of the DevCom2000
application and its functionalities.

1.4 Getting Help

If you need help or encounter problems when using DevCom?2000 or this guide, please contact ProComSol, Ltd.
See Appendix B for contact information. Please provide the following information.

Create a text description of the problem. If possible, provide the text in event sequence, which will enable
the duplication of the problem. Provide information about the system. This information must include:

DevCom?2000 version and License ID

Computer information: make, model, CPU type, clock speed, attached peripherals and operating
environment (Windows version)

Device information: make, model, and device revision

Point of contact: complete mailing address, telephone number, and e-mail address,

The date and time of the problem occurrence.

MAN-1010 05/01/2014
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2 OVERVIEW OF DEVCOM2000

Field devices such as flow, pressure, level, temperature transmitters, and valve positioners provide the physical
connection to the process. These devices allow the control system to monitor and manipulate process conditions.
HART devices maintain a real-time database of process, configuration, identification, and diagnostic information.
This information can be accessed using the HART Field Communications Protocol.

HART devices are capable of providing functions and features far beyond the basic task of providing a process
input or accepting a control output to manipulate process conditions. Many HART compatible device manufactures
create a DD (Device Description) describing all of these functions and features specific to that device. The DD also
provides information essential to the successful configuration and calibration of the device.

DevCom2000 uses these DD’s to access the data stored in a device, providing full configuration and setup support
for all registered HART DD’s.

DevCom2000 accesses and presents field device data based solely on its DD. No other files, information or custom
drivers are required. DevCom?2000 is intended to monitor and configure a single device at a time, it is directly
connected to the current loop of the particular device and:

¢ Provides user interface to configure the HART field device,
® Provides a means to configure and view all the parameters related to HART field device, and
® Provides an option to view the detailed status and diagnostic capability of the device.

DevCom2000 allows viewing and modifying of field device parameters based on the DD. Using the device’s DD,
DevCom2000 performs various tests to verify the proper operation of the HART device. DevCom2000 runs as a
standalone software package and must have a HART compatible modem attached to the system to interrogate the
HART base devices. A HART modem is not required for HART-IP communications to a WirelessHART Gateway.
In this case, an Ethernet connection is required.
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3 SYSTEM REQUIREMENTS

The following minimum system requirements are recommended for operation of DevCom2000.

PC

HART Modem

Communication Port

Operating System

Processor Speed: Pentium, 600 Mhz
Memory: 256 MB

Hard Disk Space: 500 MB

Monitor: 256-color VGA

USB to HART modem, or Bluetooth to
HART modem, or RS-232 to HART
modem. ProComSol, Ltd supplies HART
modems. Not needed for HART-IP.

USB, Bluetooth, or RS-232. Ethernet for
HART-IP.

Windows XP, Windows Vista, Windows 7,
Windows 8

MAN-1010 05/01/2014
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4 DEVCOM2000 INSTALLATION

4.1 Prerequisites
You need to be familiar with the basic functions of the following when installing the DevCom2000 tool:

e Microsoft Windows
¢ HART communication interface
e HART field device
4.2 Installing the DevCom2000 Application

To install the DevCom?2000 application in a standalone system, perform the following steps:

Step  Action

1 Insert the DevCom?2000 CD into the CD-ROM drive. Auto run
should begin installation, if not:

2 Click Start and choose Run. From the Run window, click
Browse.

In the Look In box, browse to your CD drive.
4 Double-click the drive to access the CD content.

Look for the DevCom2000Setup.exe file and double-click the
same. This process will take you through a sequence of
installation wizard steps.

6 Follow the instructions on the upcoming screens to complete the
Installation.

4.3 Activating DevCom2000

DevCom2000 must be activated before use. If the program is not activated, it will not run after 10 days. The
following procedure will activate the software.

MAN-1010 05/01/2014 Our Quality Management System is Page 9
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Step  Action

1 Start the DevCom2000 Application. The following Activation
window is displayed:

ﬂ
DevCom2000

&» Purchase DevCom2000 Online

Cpen my broweser to the online ordering page

= Activate DevCom2000

| have alresdy purchased and would like to activate the
product

=» Evaluate DevCom2000

You have 10 days left in your evaluation period

Go To Website

B Exit

If you want to evaluate DevCom2000 before purchasing, select
the “Evaluate DevCom2000” option. You will have 10 days of
unlimited program use before you will need to purchase a
license. Select “Purchase DevCom2000 Online” to go to the
ProComSol, Ltd website to purchase a license.

2 If “Activate DevCom?2000” is selected, the following window
appears:
MAN-1010 05/01/2014 Our Quality Management System is Page 10
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I pevCom2000 Activation x|
DevCom2000

Activating DevCom2000 is simple and quick.

Please select an activation option:

=y Activate DevCom2000 Online

| have a valid License D

& Activate Manually

| will cortact & support representative

Click here for support

&3 Back B Exit

3 If the “Activate DevCom?2000 Online” option is selected, the
following window appears.

DevCom2000

Please enter your License ID and Password found on the CD
Label or received through your email.

Please enter yvour License Ik

Where is my License 1D

Please enter your Password:

Click here for support

&= Back B Exit Continue ]

Enter the information from the Activation label on the CD case.
Select “Continue” to process the information.

If the codes were successfully entered, the program will continue
as normal. You will not need to perform the activation process
again.

MAN-1010 05/01/2014 Our Quality Management System is
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4 If the “Activate Manually” option is selected, the following
window appears:
x|
DevCom2000 Activation
Please call 216.221.1550 to activate DevCom2000
User Code 1: User Code 2:
| 295962078 | 86636908
Activation Code 1: Activation Code 2:
Click here for support
(‘;ZI Back g Exit Continue I@

You will then need to contact ProComSol, Ltd to obtain the
Activation Codes. You must supply the User Codes to
ProComSol, Ltd support personnel (Your user codes will be
different than those shown here). You can register manually in
any of the following ways:

1. Call ProComSol, Ltd at 216.221.1550. Have the program
License ID and User Codes ready.

2. Or, send an email to support@procomsol.com containing your
company name, License ID, and User Codes.

3. Or, send a fax to ProComSol, Ltd (216.221.1554) containing
your company name, License ID, and User Codes.

The above information will be processed at ProComSol, Ltd and
an appropriate response will contain the required Activation
Code information that the user will need to enter.

If successful, the program continues as normal. You will not
need to perform the activation process again.

5 We have tried to make the Activation process as easy as
possible. Contact ProComSol, Ltd if you have any difficulties.

MAN-1010 05/01/2014 Our Quality Management System is Page 12
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4.4 Connecting to the HART Network

The DevCom?2000 application communicates with the HART Field Devices through a HART compatible
communication interface (e.g., a "HART Modem"). Using this communication interface you will transmit real-time
HART data between DevCom2000 and the connected HART compatible field device.

There are a wide variety of HART compatible interfaces. Please follow the manufacturer’s instruction for
connecting your interface to the PC. This manual uses the HART modem manufactured by ProComSol, Ltd, called
the HM-USB-ISO. It uses the USB interface.

Insert the USB connector on the HM-USB-ISO into your computer’s USB port. Using the clips on the wires from

the HART interface, connect to the device across the 4-20ma signal. If a suitable load resistance is not available, a
250€ resistor must be placed in series with the device power supply.

Devi_om 2000

HART Field Device

=

Windows PO HART Interfoce

o i ufrei= fu g e o

Figure 1 Typical DevCom2000 Hardware Setup

4.5 Uninstalling the DevCom2000 Application
To uninstall the DevCom2000 application, perform the following steps:

Step  Action
1 Click Start 2 Programs - ProComSol - DevCom2000 -

Uninstall DevCom2000

2 Or, Click Start - Settings 2> Control Panel > Add/Remove
Programs

3 In the Add/Remove Programs dialog window, select the

DevCom2000 program that you want to uninstall.
4 Click Remove.

Click OK to confirm the removing of the selected application.

MAN-1010 05/01/2014 Our Quality Management System is Page 13
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S USING DEVCOM2000

5.1 Starting DevCom2000

The HART compatible field device must be connected to a PC or tablet running DevCom2000 to configure or
calibrate the field device, or to view the field device's data. Make sure to establish the physical connection between
the field device and the DevCom2000 computer. With the physical connection established, launch DevCom2000
by clicking the DevCom2000 icon on your desktop. You can also start the application by going to your computer's
Start Menu and selecting Start 2 Programs 2 ProComSol - DevCom2000 - DevCom2000.

If your computer is running an anti-virus program such as McAfee, you may get a message about a program
wanting to access the internet. This is normal. DevCom2000 uses TCP/IP to communicate with the
Communication Log program.

Step  Action

1 Start the DevCom2000 Application. The following application

window is displayed:

Y DewComa00 - [Exphorer] —
W' Device Opoors View Enhanced Trending DD License  Window Help -
2 2 B8

P e |

. e Wahue | Uinins

L3 Cwereew
13 contigure
3 Servce Took

DevCom2000 will then automatically identify the field device and
open a communication channel to (i.e., a connection with) the field
device.

2 Setting Options Options = Basic

If communications cannot be established, you may need to change the
communication settings using the Options dialog box.

The serial port box will show the available com ports. Select the one
your HART modem is using.

MAN-1010 05/01/2014 Our Quality Management System is Page 14
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[ Options @

Basic ISearch By | Advanced

Modem Server Preferences

Serial Port ComM4an hd (awvailable)

Onling DewCom2000

[ Use TCPAR with WirelessHART Gatewsay

P Addrass | 192 166 1 1 Advanced Settings
Port 5094

[T Use HART Server with WirslessHART Gatewsay or HART Multiplexer
(MNote: HART Server must be purchased from the HART Foundation)

OK Cancel | Restare Defaults ‘

3 You may also change the polling options for the computer. If you do
not know the poll address of the device you are trying to communicate
with, use the default address O setting. To do this either click on the
Search By tab or go to Options -> Search

Options ﬁ

Basic  Search By |m:hmncecs|

Search By

Foll Address LI Search by Tag

Search by Poll Address
WirelessHART Adeptar - Dofault
® uze poll addiess 0 only  ABE FisldKey-15

 find first poll address  Emerson THUM-63

[ Il add 5]
e " EndrivssHausor SWATD-15
" search 0-15
" MACTek BULLET -15
" search 031
' |+ -1
 spach e Pepperl+Fuchs WHAADP - 15
— " Phoenic Contact RADWHA - 63
" searchrange: |0 thegugh (0 SR

" Siemens SITRANS AWZ00-15

Ok | Cancel | Restors Defaults |

Make sure that Poll Address under Search By is selected.

MAN-1010 05/01/2014 Our Quality Management System is Page 15
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When the device is connected to DevCom?2000, the browser window
appears with online (i.e. root menu) selected.

A, Dm0 - [Fapioner] e

® | Devicr Options View Entanced Trending DD Licerne  Window  Heip
2 2 ER
W Ol

Tag P-101 - LongTag Do TEST LT Dmace: 3051 - DIl 2060307 ) HART Actat| () Trend Actned MU

The left pane of the window shows the menu structure and the right
pane of the window displays corresponding parameters of the menu
selected.

The DevCom?2000 screens shown in this document are only an
example of what you may see when connected to your field device.
What you see is actually controlled by the DD and the device. The
menus, data, status and configurations displayed are specified by the
field device's manufacturer in the DD itself.

Select the required menu to configure or review the field device's data.

5.2 Getting Familiarized with DevCom2000 Explorer
5.2.1 Using the Menus
DevCom2000 Explorer provides visual representation and structure of the application window.

Menu Explanation

Mew Device Chrl+h The Device Menu offers the following

Document Device sub-menu options:

Do el New Device - Connect to a new device or

Exit .
reconnect to the same device.
Document Device — Brings up the
Document Device dialog box.
Download / View — Brings up the
Download dialog box which provides
Configuration File features.
Exit - Exit DevCom?2000.

MAN-1010 05/01/2014 Our Quality Management System is Page 16
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Biasic The Options Menu offers the following

Search sub-menu options:

Pz Basic- Select what COM port the device
is connected to and use WirelessHART
gateway.

Search- Search by Poll Address, Long or
Short Tag.
Advanced- Select HART Master,
Language, and DD Startup.
v Toalbar The View Menu offers the following sub-
W Stabus Bar menu options:
Cammunication Lag Toolbar - Hide or show the Tool Bar.
Device Condition Status Bar - Hide or show the Status Bar.
ErETI LS Lo Communication Log — Open the
Communication Log window.
Device Condition — View detailed device
status.
Event-Status Log — View log of events
and status changes
Example of available The Enhanced menu offers enhanced
Enhanced Menus: device menus. Some devices do not have
Enhaniced View Below (F available) enhanced menus and this menu will only
Start say “Enhanced View Below (if available).
Device Diagnostics
Process Variables
No Enhanced Menus
available:
Enhanced Yiew Below (if available)
Define Trend The Trending menu offers the following
Wiesw Current Trend Sub_menu Optlons:
Wigsw Past Trend . ) .
5:?; C‘Zirerf :r:n 4 Define Trend — Brings up the Define
Trend dialog box where a trend is started.
View Current Trend — Brings up a real-
time graph of values currently being
trended.
View Past Trends — Brings up the View
Trend dialog which contains past trend
files. Selected trend files can then be
graphed.
Stop Current Trend — Stops the current
log in process.
MAN-1010 05/01/2014 Our Quality Management System is Page 17
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Add DD The DD menu offers the following sub-
Available DDs menu options:

Add DD - Brings up the dialog that adds
a DD to the library. Also used to give
labels to non-standard library DDs.
Available DDs — Brings up a browser of
all the DDs installed in the library.

Launich FDT Frame i The DTM menu offers the following sub-
menu options:

Launch FDT Frame— launches the FDT

(Future)
Frame program.
DewComz000 Help The Help menu offers the following sub-
Com Troubleshooter menu options:
EE“C:[:'E":: o DevCom2000 Help — Brings up Help
SHb A information for the DevCom2000
application.

Com Troubleshooter — Brings up the
DevCom2000 Com Troubleshooter.

Device Help — Brings up help information
for the connected device (if available).

About DevCom2000 — Shows copyright
information, support information, and
application Version Number.

5.2.2 Using the Toolbar

When you start the application, by default, the toolbar buttons appears on the main window. If it fails to display,
click View - Toolbar option from the menu bar to bring up the toolbar.

Following are the buttons available in the DevCom2000 application toolbar to perform the necessary tasks:

Button Description Corresponding Menu Option

Connect to a new device Device 2 New Device

Send parameter changes to the
device

Cancel parameter changes
View more status on Device View = Device Condition

and Communication
(Command 48 status)

) &) b=

View Communication log View - Communication log

=

MAN-1010 05/01/2014 Our Quality Management System is Page 18
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View Event log View - Event-Status log
'. Launch FDT Frame (Future) DTM - Launch FDT Frame

5.2.3 Familiarizing with Icons

DevCom2000 application uses different icons to represent different elements of the application. Following table
lists the icons and their meanings:

Icon Meaning

Indicates a menu or submenu in the navigation tree

Indicates a currently selected menu or submenu in the
navigation tree

Online menu icon. The actual DD menu comes under this.

Indicates a “Variable” item

Indicates a “Method” (Standard Operating Procedure) item

@6 &R [ I

Indicates an “Edit Display” item
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6 FUNCTIONS AND BASIC OPERATIONS

6.1 Overview

DevCom2000 allows the user to monitor and configure a single device at a time in the field. Each device is
associated with the DD when the device information is present. A DD may contain any of the following
parameters/elements:

Variable

A variable is defined as the data contained in the device (e.g. Device Firmware Version). There are two types of
variables:

Editable Variable — It allows the operator to modify the value and download it to the device.

Non-Editable Variable — It is a read-only data from the device.

Edit Display

This option is used to view a group of parameters. You can also modify a single parameter from this group, based
on which other parameters of the device get altered.

For example, if the Engineering Unit of the device is modified, the corresponding Low Limits and High Limits
change as per the Engineering Unit set.

Method / Standard Operating Procedure (SOP)

This option helps to perform various tests on the device for instance, Self Test and Loop Test. A Method or SOP is
a series of steps that are executed in a sequence results in the completion of some device related tasks. When a
method gets invoked, it gives various warning messages and options to the user, by which the user can thoroughly
test the device. If a test is aborted by operator command at any stage of the sequence, the method invokes
additional steps to bring the device back to its original state before the test.

6.2 Viewing Device Configuration (typical, actual view may change based on DD)
To view the configuration of the device that is connected to DevCom?2000, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:
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Step  Action

o DevComand - [Exploner] -
B Dewce Opoors Veew Enhanced Trending DO License  Window  Help

a 2 88
- P

13 vernew
12 cosigure
b3 Servier Teoh

Tag P-100 - LongTap Mesc TEST UNIT Device 3051 - DIk 26060307 ) HART Actrwt| 00 Toend detwit W

The left pane of the window shows the menu structure and the right
pane of the window displays corresponding parameters of the menu
selected.

The menus are displayed depending on the type of device that is
being connected. These menus are displayed based on the DD file
of the particular device.

If no DD is available for the device the DevCom2000 will select
the standard DD. This should provide limited functionality for the
device. NOTE: If a parameter is updated that is not supported by
the device you will receive an error.

2 Expand the menu by clicking the “+” sign and double-click to view
the device parameters. Below is an example of an expanded menu:

| Device Optioes Wiew  Entanced Trending DD Licente Wingow  Help

IE] LI

Tag P101 - LongTag e TEST UNIT Ewvice: 3051 - DD: 2608807 ) HART Acteit| (D) Trend Activd L]

3 Select the menu and view the associated parameters to view the
device information.
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6.3 Configuring Device Information
6.3.1 Overview

DevCom2000 allows you to view and configure the field device parameters based on the device description.
However, the device vendor defines most of the parameters at the factory. These parameters become read only
for the users and the user cannot modify the values. The related variables are grouped under various menus of
different levels as defined in the DD file. Expand or collapse the tree view using the “+” or “-“sign to access
the device configuration parameters.

Following table describes the details about the device configuration:

Step  Action

1 Ensure that the application is running and communications have
been established:
Y, DesComaon) - [Exploder] v
& Devce Options View Enfanced Trending 00 Licerse Window Help
2 g E@
[ ¥ onine hem Vahe
| = & overview M Chrwicie St
| S et el
]
& Upgerr Barge Vabs il
e chiogal Hpeta
[Tog P10 - omgTagsDesc: TEST UMM - Doevice: 5051 - 0 28/060307 € HART Act| ©p Teena Activit

The left pane of the window shows the menu structure and the right
pane of the window displays corresponding parameters of the menu
selected.

2 Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

3 There are three types of variables: dynamic, read/write and read
only. The parameters that are grayed out indicate that these are
dynamic variables (variables that get updated online by the device)
or read only variables.

Following points describe how the device parameters represents
their status when connected to DevCom2000:

Bold Font: Modifiable Values
Normal Font: Menu Item

4 Select the parameter and configure the values, as required.
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Step  Action

5 The subsequent topics explain how to configure device parameters.

6.3.2 Variable

To edit the parameter variables of the connected device, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:
%, DesComaa0D - [Expkoder] ——
% Devce Options View Enfanced Trendng DO Licerse Window  Melp =
2T 8 @@ : :
@ Oniine hem | Vbt | Uit
o o Overview 1 Dervice Staten oo
© O Cordgure o Comrn Stanu Bueit
5 Servioe Tool [
.-
1 Upger Rarge V... A0 aHIT
8 Lomar Rarge Vihua(t ma} Rp—
1 Dewice nformation
Tasge P01 - LruyTagyDee: TEST LT Diewice: 3061 - D 26/05/0307 O HART Acther| D) Teend Activit WU

Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

2 Select the menu where the editable parameter is present as shown

below:

ER Onlirge

= 3 Con

Tag: P-101

%, DevCom2000 - [Explorer]
8 | Device Optiors View Enhanced Trending DD License Window Help
RTET 2 BB

=L Owirview
& Device [Mormation

3 Tdentification
3 HART
2 Mabenials of Construction
13 RS Materials of Construction
=2 Analog Alarm
3 Security

digure

= ) Guided Setup
L3 Basic Setup
3 Configure Display
=00 Marual 54lup
=] Process Vaniables
2 Anatog Output
3 Display
0 HART

L Security
22 Dwnvice Informiation
O Mentfication
L Flange
3 Darnata Gasl

- LongTag/Dese: TEST UNIT

g =

Value | Units i

* | loem
M Pressure Usits insiaty
'Y Bamping .80 sec
' transler Function Limear
M Semnor Temperature Usits dogl
& .
K 5

- Denace- 3051 - DO 26/06,/03,07

) HART Activit

@ Trend Activit NUM

3 Double-click the variable to edit it. The following dialog box
appears on the screen:
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Step  Action

2 Configure Display
=13 Manual Setup
4 Process Yarables
Q) Analog Output
O Display
£ HART
O Security
& & Device Information
(3 Jdentification
2 Frange
"2 Rarns Sanl

(Tag: P-101 - LongTag/Desc TEST UNIT

o DevComaDi0 - [Explorer)

'} Device - Options  View Enhanced  Trending DD L v He
|
AT T B EE _
& Oniine « | Hem Walise | Units
B Owefvidw Q Pressure Usils inH20
= 3 Dece Information M Damgang 080 sec
0 Identification " Transfer Function Linear
£ HART 4 Semvor Temparatune Usits degt
& Materials of Construction - 7 ink
T
£ RS Matsrials of Conmruetion | Soo0! Temperature Units s
& Analog Alarm
degC
O Seturity 2
By ] -
= 1 Guided Setup
£ Basic S#tup

- Device: 3051 - DO 26/06/03/07

| @ HART Actvit @ Trend Activit 1

4 Make the changes to the parameter value, as required.

N

Click Set to accept the changed value. The change gets reflected
as shown:

%, DevCom2000 - [Bxplorer]

® | Device Options View Enhamced Trending DD Licenss Window Help

FeF 2 BER
& & Onlire
=1 Overview
= & Device Information
3 Identification
3 HART
& Materials of Construction
= RS Materials of Construction
=9 Analog Alanm
3 Security
=3 Canfigure
O Guiged Setup
3 Rasic Setup
& Conhguee Display
= Marmal Setup
=3 Process Vaniables
9 Analog Chiput
3 Display
3 HART
2 Security
=10 Device Information
3 Kentification
3 Flange

3 Bk Saal

= (=)
E

= | Iveim Value | Units
" Prosaurs tnits nbzE
M Damgping 0,80 wne
M Transier Punction Lingar
15 genvor Temparstisra Units

| —

dagr

- Device: 3051 - DO 26/06,03/07

|Tag P-101 - LongTag/Desc TEST UNIT € HART Acthit| (D Trend Activit MU
6 Click on the Send icon B to commit the changes to the device.
7 When the value is no longer yellow, the variable has been changed

in the device.
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Step  Action

A, DevComa000 - [Explorsr]

BT BB
& Ondine
= L Owerdew
=-[2 Device Infedrmation
5l Confagune
2 Guided Setup

B | Device Oplions View Enhanced Trending DD License Winoow Help

= |lem

Vaive | Units

% Frossurs Units

=4 Damping

" Transter Fanctssn

' Sensor Temperaluse Bnits
M pressure

[
00 e

Lbnear
degF

O Baic Setup
3 Contigure Display
3 Manual Setup
& Process Variables
O Analog Output
i Dhsplay
& HART
L Security
= Deice Information
2 Identification
2 Flange
& Remate Seal
2 Sevice Tools
3 Alests
3 Vaiables
=2 Trends
= @ Maintenance

)

¥ Tirwwd i

Tag: P-100 - LongTag/Desc TEST UNIT - Deice: 3051 - DDx 36/06/03/07

The Send and Cancel Icon will now be grey as well. This indicates
that there are no new changes to be sent to the device.

@ HART Activit. €3 Trend Activit NUM

6.3.3 [Edit Display
The Edit Display is a variation on the Variable edit. An additional window helps the user view a group of
parameters based on the DD. You can also modify a single parameter from this group. Parameters linked to

the edited field will be updated automatically

To view and configure these variables, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established

% DevCom2000 - [Explorer] = | [E] S
[# | Device Options View Enhanced Trending DD License Window Help N EE
RITE & B
=& Online Ttem Value‘ Units

=] | Device Status: Good

=-(3 Configure M Comm Status: Burst

(@ Service Tools 1% Pressure 2.1inH20

1% Analog Output 11331 mA

") upper Range valu...
2 Lower Range Value(a mA) -30.0 inH20
I Device Information

< I 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| (2 Trend Activit NUM

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.
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Step  Action

2 Select the menu where the required variable is present as shown
below:
DeonmZ[ll]l] - [Online] - | Dlil
Device Options  View Enhanced Trendng DD DTM  Window Help - x
u hanced d d | -
AEEIEIE I
= Item Walug | LUniks |
=-{_] Device setup |_] Device setup
{17 Process varishles 2y P 0.00 deqC
. DiagjServi 3y F¥ AO 0,00 md
® g B:S?i szrtEI;E ¥y P¥ LRY 0.00 degC
[=-{] Detailed setup % P¥ URY 0.00 degC
{1 sensors
(1] Signal condition
Output condition
-] Analag oukput
-] HART output
] Meter Options
Device information
{:l Revision #'s
L] status
{0 Review
|Tag: TestDev - LongTag/Desc: Dev Desc Here - Device: 3144 Temp - DD: 26| 0 HART Activity | @ Trace Activity v

3 Double click the parameter you wish to edit. The following dialog
box appears on the screen:

Dev[an[l[l[l - [Online] - |EI il
"] Device Options Wiew Enhsnced Trending DD DTM  Window Help == x|
REG 2 BEN|
=25 online | Ttem [ Valug [ Units [
EH{{] Device setup Devire sehn
o TR W ik As One Edik Display x| o.00 degC
{1 DiagyService I0.00 ma
{2 Basic setup Edit Display :;:: g:gg
=] Detailed setup Itern | Value | Units ) 9
(] Sensors D T... 0.00 degC
{1 Signal condi i T... 0.00 degC
-2 Output cor
-{ &nalag
(] HART o
A 3
{23 Meter ¢ I | J
[=+{] Device infar
{1 Revisior
{1 status
{1 Review
\Tag: TestDey - LongTag/Desc: Dev Desc Here - Device: 3144 Temp - DD: 26| @ HART Activity | ) Trace Ackivity v

4 Double click the parameter you wish to edit. The following dialog
box appears on the screen:

M pevComz000 - [Online] — o] x|
7] Device Options View Enhanced Trending DD DTM  Window Help - ﬂ|§|

R720 2 nB ¥
= @Onhne @ | \u'a\uel Units |

[=-{_] Device setup

(0] Frovess varisbles = 000 deC
| 0.00 ma
Rl i 25 one x| 000 desc

0.00 degC
(0 Detallet g Display— oo i
1 ser — Ok |
(2 sigr Q‘,\t—em
B3 out T et Cancel I
R T
B3 by 4] i Hl
~a
-0
--(20 Review
[Taq: TestDev - LongTag/Desc: Dev Desc Here - Device: 3144 Temp - DD: 26| @ HART Activity | ) Trace Ackiviey v
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Step  Action
5
6

Make the change to the value, as required.

Click Set to accept the changes. Or press Cancel to cancel the
changes.

Click OK to close the dialog box.

DevEanl]I]l] - [Online] .

1Ol
] Device Options Yiew Enhanced Trendng DD DTM  ‘Window Help - ﬁ‘lﬂ
AR 2 BElw|
=3 orine Teem value | Urits |
=-{_] Device setup {_] Device setup
{11 Pracess variables Ky P 0.00 degC
(] Diag/Service D, Py A0 0.00 mé
{11 Basic setup 1y P¥ LRY 0.00 degC
N
=] Detailed setup K PY¥ URY 10.00 degC
-] Sensors

(10 signal condition
{3 Output condition
{12 Analog output
L] HART autput
{7 Meter Options
=1 Device information
] Revision #'s
1] Status
~{] Review

|Tag: TestDev - LongTagfDesc: Dev Desc Here - Device! 3144 Temp - DD 26| o HART Activiky

| @ Trace Activiey

I

Again the yellow means the parameter is changed and ready to be
sent to the device.

Click on the Send icon B to commit the changes to the device.
9 o - _

Devl:oleJDD - [Online]

=101l
) Device Options View Enhanced Trending DD DTM  ‘Window Help - ﬁ'lll
RIE0 (2 BE|W]
B Ttem value [ Units |
=-{_] Device setup |_] Device setup
{11 Pracess variables iy P 0.00 degC
-] Diag/Service lh Py A0 0,00 mé
-{1] Basic setup 19 PY LRY 0.00 degC
2y PY URY 10.00 degC
B-{1] Detailed setup & egq
-] Sensors

{11 Signal condition

Qutput condition

{1 Analog output

{0 HART output

H (£ Meter Options

[=-[L] Device infarmation
L[] Revision #'s
(] Status

{1 Review

|Tag: TESTDEY - LongTag/Desc: DEY DESC HERE - Device: 3144 Temp - DE| @ HART Ackivity | () Trace Activity

Crr
After being sent the change is reflected in the device info.

6.3.4 Executing Methods or Standard Operating Procedures
Methods are defined in the DD file for the device that DevCom2000 is connected to. You can select the

Method and execute it for calibrating the device, trouble shooting, etc. Method execution leads you through a
number of steps, like in a wizard.
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A Few examples of methods include:

- Setting high and low range calibration points

- Calibration of the device

- Run the advanced diagnostic test procedure

- Execute tests to gather information on device operation.

To execute a Method, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:
%, DevCom2000 - [Explorer] = B et
'] Device Options View Enhanced Trending DD License Window Help -[&| =
AT |2
&2 Online Item Value ‘ Units
ﬁm I Device Status: Good
3 Configure % Comm Status: Burst
2 Service Tools 12 pressure 2.1inH20
1 Analog Output 11331 mA
9 upper Range Valu... 40.0 inH20

1) Lower Range Value(4 mA) -30.0 inH20
I3 Device Information

< i 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 o HART Activit @ Trend Activit NUM

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

2 Select the menu where the method is present and double-click to
execute it.
3 Below is an example of a Method dialog box:
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Step  Action

Uy D200 « [Expheres]

@ Z >
& vl « | bem ae| bnity

3 O

]
—— 1)
(=1 Sensor Temperature Ursts A
eyt
o
Cancel
Tag P-101 - Long TspDesc TEST UNIT Dewsce 051 - DOE 200307 ©r HART Actwit. () Tresd Actrat UM

Click Set to open a Method dialog box:

Send warning

Variables which use this as the units code will bie inthe prenious units until this value is sentio the device

Press OK button to continue method execution or Abort button 1o abort method execution,

QK Abaort | Help

4 Click OK to move to the next dialog in the Method sequence.
Or, click Abort to cancel the Method execution.

6 Click Help to get specific help for that step of the Method. This
Help information is provided by the device DD.

6.4 Calibrating HART Field Devices

Calibration of field devices and loop test are achieved by executing the Methods or Standard Operating Procedures
that are specific to device. Methods are defined based on the test parameters specific to the device, providing
information for the calibration of that device.

See the previous section for Method execution.
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6.5 Viewing the Device Status

DevCom2000 provides the user with the ability to monitor the device specific status of the device and the
communication network.

When there is error communicating with the device, it is recognized and indicated to the user. The user can view
more details of such errors, using the View = Device Condition from the main window.

To view the device and communication status, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:
2 %, DevCom2000 - [Explorer] = |E
[#'] Device Options View Enhanced Trending DD License Window Help - = =
R @
=42 Online Item Value ‘ Units
B ﬁm 1 Device Status: Good
3 Configure ) Comm Status: Burst
3 Service Tools 1 Pressure 21inH20
& Analog Output 11331 mA

' Upper Range Valu... 40.0 inH20
|2 Lower Range Value(4 mA) -30.0 inH20
I3 Device Information

7 1 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| € Trend Activit NUM

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

3 Select View = Device Condition from the main window or choose
the status icon @ from the toolbar. Following window is displayed:
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Step  Action
Device Condition = &1

Device Status | Status group 1| Status group 2 | Status growp 3
Device Status

0 Device malfunctioning

O Configuraion changed

9 Coldstan

0 More status avaitable

O PVAQfued

9 PVAD saturated

©  Mon primary variable out of limits

O  Pomary variable out of limits

The Device Status tab option shows the status of the device and the
communication network. The individual status is indicated by green
and red LEDs.

4 Additional tabs may be available depending on the DD.

Click X to close the Status window.

6.6 Viewing the Communication Log

DevCom?2000 allows the user to view the actual communications between DevCom?2000 and the device. You can
view send commands and received responses.

If your computer is running an anti-virus program such as McAfee, you may get a message about a program
wanting to access the internet when you open the Communication Log. This is normal. DevCom2000 uses TCP/IP
to communicate with the Communication Log program.

If no data appears in the Communication Log, this may be due to an anti-virus program. Close the Log window and
re-launch.

To view the communication log, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established
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Step  Action

%, DevCom?2000 - [Explorer] HE~
[#'] Device Options View Enhanced Trending DD License Window Help & 5.‘ x:
EIEEIEI
=-£3 Online Item Value [ Units
= | Device Status: Good
(3 Configure 1 Comm Status: Burst
®-(3 Service Tools 2 pressure 2.1inH20
& Ana og Output 11331 mA
' upper Range Valu... 40.0 inH20
' Lower Range Value(4 mA) -30.0 inH20

I3 Device Information

| 11l | r

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 | @ HART Activit, ) Trend Activit| INUM \ ] A

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

2 Select View - Communication Log from the main window or

choose the communications log icon B from the toolbar.
Following window is displayed:

- ~
BB communication Log |= 1 @ﬂ
| EA File Edit View Window Help =]

D& » QP 7
Scrinll Data Stream -~
50 S5TX 0110 00
EE] Ack 0110 12 00 00 Olbf c854 cl20 4lad e000
a8 5TX 0110 00
47 Ack 0110 12 00 00 O1bf c768 1720 4lad €000 =
46 S5TX 0110 00
45 Ack 0110 12 00 00 Olbf o538 b320 4lad e000
a4 5TX 0110 00
43 Ack 0110 12 00 00 O1bf 538 b3I20 42lad &S00
42 S5TX 0110 00
21 Ack 0110 12 00 00 Olbf o538 b320 4lad e500
40 5TX 0110 00
39 Ack 0110 12 00 00 OQ1bf 538 b320 <lad e000
EE S5TX 0110 00
57 Ack 0110 12 00 00 O1bf o538 b320 4lad e000
36 5TX 0110 00
35 Ack 0110 12 00 00 O01bf o538 b320 <lad e000
34 S5TX 0110 00
33 Ack 0110 12 00 00 Olbf o504 &b20 4189 e800
3z 5TX 0110 00
51 Ack 0110 12 00 00 0Q1bf c4d0 b520  ¢lad  e00Q g
of 1]} L3
|Ready NUM

Note: The communications log lists actual HART commands and
the responses from the unit. A good understanding of the HART
protocol is required to interpret this data.

3 Select File = Exit to get back to the main window. Or, close the
Communication Log window by clicking on the X.
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6.7 Viewing the Event-Status Log

DevCom?2000 allows the user to view the error conditions of the device and the communication network.

To view the Event-Status Log, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:

% DevCom2000 - [Explorer] ‘ =|E -V;hq
[#'] Device Options View Enhanced Trending DD License Window Help - =] =
RE2H |2
=& Online Ttem Value | Units

- ﬁm @ Device Status: Good

-3 Configure @ Comm Status: Burst

&~ Service Tools I Pressure 2.1inH20
@ Analog Output 11331 mA
D Upper Range Valu... 40.0 inH20

% Lower Range Value(4 mA) -30.0 inH20
I3 Device Information

<[ 1l 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| T Trend Activit NUM

Expand the menu by clicking the “+” sign and double-click to view
the device parameters.

2 Select View = Event-Status Log from the main window or choose

the Event-Status log icon £ from the toolbar. An additional Event
Status window is displayed:
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Step  Action

. Dm0 - [Exploner] ——
B | Dewice Optdsd Vebw  Eahbaced Treading D0 Lioesss Winidtw  Hels
ATa 2 BB
= I [ Vakae | Units
13 Svervigw
139 Configrre

1 Service Toon

Tag P-100 - LoegTag/Thesc TESTUMIT - Device: 3051 - DD: 26/DE/03,07 ) HART Aot Trema mcr] P

3 To close, go to View = Event-Status Log menu option or click on
the & icon to go back to the original window.

6.8 Saving Device Configuration to Disk

HART Device configurations can be saved to disk as a text file to document the device. Fields are delimited with a
comma so that the data can be imported into configuration management software packages. A PDF version of the
configuration is also created.

To save device configurations to disk, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:
. DevCom2000 - [Explorer] = [[E] |-
[#'] Device Options View Enhanced Trending DD License Window Help - =] =
REF 2
=2 Online Item Value| Units
EM ' Device Status: Good
(2 Configure % Comm Status: Burst
&3 Service Tools 1 Pressure 2.1inH20
& Analog Output 11331 mA
' upper Range Valu... 40.0 inH20
' Lower Range Value(4 mA) -30.0 inH20

I3 Device Information

< I 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 | @ HART Activit| € Trend Activit NUM
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Step  Action

2 Select Device 2 Document Device from the main window. The
Document Device Dialog Box is displayed:

Document Device ﬁ
File Marme
|C".F‘ro-;ranlIei\F’mI:DmSuu"LDevCornZ’EIDD’\TESTDEV_'I Ieat Browse
Motes:
"Mofes" must be less than 250 characters
[ Sawve Device Config | FOF Setup | Cloge |
3 The default directory is based on Windows User Accounts. The

default file name is Tag_Device ID. The directory and filename can
be changed by the user. Use the “Browse” button to change
directories and/or filenames also.

4 Enter a Note in the Notes: field if desired. Maximum of 250
characters.

5 Press the “Save Device Config” button to save device configuration.

6 If the filename has already been used, the following Dialog Box is

displayed when Save Device Config is pressed:

FileExists X

File Exizts; Pleaze chooze fram below:
" Append 12
£ Dwenwrite

" Cancel

Append: Adds the number shown to the end of the file name
Overwrite: Deletes and writes over the existing file
Cancel: Returns to the previous menu
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6.9 Download Configuration to Device

Saved configuration files can be downloaded back to devices. This is useful for “Cloning” a device, either for
replacement or plant setup.

To save device configurations to disk, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have been
established:

%, DevCom2000 - [Explorer] (=[5 [l |
[#'] Device Options View Enhanced Trending DD License Window Help - =] =
RTFAE
2-& Online Ttem Valual Units

ﬂm 1 Device Status: Good

=3 Configure % Comm Status: Burst

(3 Service Tools ' pressure 2.1inH20
& Analog Output 11331 mA
2 upper Range Valu... 40.0 inH20
% Lower Range Value(4 mA) -30.0 inH20

I3 Device Information

A m 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03,/07 o HART Activit O Trend Activit NUM
2 Select Device = Download from the main window. The Download
Dialog Box is displayed:
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Step  Action

Downboad File &

#Apsailmble Tonfiguratons (Double Click to Selec)

N |Tag | LoagTagDe . | Device | Dote | File: | Hotes

Mmoo T-104 WERIFY DES.. TwWT162 2002-02-03 Chillzers\hni

02 T-104 VERIFVDES., TWTIEZ 2013-10-m 1 Founs Blue

Wi FURETY LAWLBZULLY . 201N Iwo Fiecs

4 P-101 TESTUNT 051 2013-10- T Shape

s RADSMHAS TAGTEST i _RAD_WHA 201 3=10-01 wirchoao

Deviza Tag:  [P-101 Bowse
Corfiguration Fi e Teg Erter new ~ag if desi-ed (8 Characer Mes)

LongTagDusaipton.  [TEST UNIT

Confg. Sile LoagTagDesc

Jeack: |

File Mame: |

Date: [

Hotas

Crolete Close

3 The available configurations are displayed. You can sort on each
column by clicking it.
To get details about a configuration, select the desired configuration
and double click it. The details will be displayed below.

4 You can change the desired Tag by editing the Configuration File
Tag box. You can change the desired Description by editing the
Config. File LongTag/Desc box.

5 Press the “Write” button to write device configuration. The device
must be the same type as the configuration file. If they are different,
the write operation will be aborted.

6 You can view the PDF file for the configuration file by double
clicking on the desired configuration and pressing “View”.

7 You can delete configurations by double clicking on the desired
configuration and pressing ‘“Delete”.

6.10 Customizing PDF File Output

HART Device configurations can also be saved to disk as PDF Files to document the device. The header, footer,
and technician name can be entered to customize the PDF file to make it into a configuration report.

To customize the PDF output, perform the following steps:

MAN-1010 05/01/2014 Our Quality Management System is Page 37
ISO 9001:2008 Certified



\; PROCOMSOL
DevCom?2000 User Manual

Process Communications Solutions

Step  Action

1 Press the “PDF Setup” button on Document Device Dialog Box:
Document Device Iéy
File Mame
|C:\Pr0gram Files\FroComSol\DevComa000W\FDFTest_1 .t Browse

MNotes:

"Motes" must be less than 260 characters.

Sawe Device Config | PDF Setup Close

b

2 The PDF Setup Dialog box is displayed:

PDF Setup
Header: |User Manual Device Config
Footer: |F00terf0r Device Config
Tech: |Guy|nstrument
PDF Text Scaling
Scale Walue: |36
MNote: Larger the walue, the smaller the text
96 is default value. use 120 on small screens.
OK | Cancel |
3 Enter data as needed and press OK. The data is saved for future

configuration saves.

4 Below is a sample PDF file.
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Step  Action

User Manual Device Config

DevCom2000, Rev 4.6, Device Configuration File

File: C:\Program Files'\ProComSchDevComZ00NWTESTDEY _1-1.pdf
Tag: TESTDEV

LongTag/'Desc: DEV DESC HERE

Device ID: 1

oD: 26/12/01/08

Date (vywy-mm-ddi: 2011-02-17

Time (hr-mn-sc) 02:58:57 PM

Tach: Guy Instrument

Motes: this is a saved device config

Label Malue Units
Hier fnctn Lingar

Al 0.00 A
AD alrm typ H

Unit ahm

Tearm temp umit degh

%% rnge [ uln]

Term temp [ ulu] degC
Term Upr Rng 1000 degC
Term Lor Rng [ ulu] degC
Term temp USL 0.00 degC
Term temp LSL 0.00 degC
Term temp damp 0.00 5

Diff min span 0.00

Snsri 000 ahm
Snsrl snsr sin 1

Snsr1 Upr Rng 0.00 ohm
Snsrl Lor Rng 0.00 ahm
Snsr1 USL 0.00 ahm
Snsri LSL 000 ahm
Snsri damp 0.00 5
Snsrl Min Span 0.00 ohm
Snsr 1 Type Thms

Snsr 1 Conn 2 Wire

Meter typ Eng unit

MMeter decimal pt Floating decimal pt

Meter bar graph Sar graph off

50080 Hz filter &0 Hz

Snsr 1 Cal Mode Factory Trim

Foofer for Dev Config Fage { of 3

6.11 License File Transfers

The license file can be transferred easily to other computers. The process is a “Check-In/Check-Out” process.
When a license is on the computer, it is considered “Checked-Out”. When the license is on the license server, it is
considered “Checked-In”. When the license is “Checked-in”, it can be “Checked-Out” by other users. This enables
the license to be shared by many users.

6.11.1 Check-In
To Check-In the license from the current computer to the License Server, perform the following steps:

Step  Action

1 Verify your PC is connected to the Internet.

2 Select “Check-In” from the “License” Menu.

If the current computer is not licensed, an error message will
appear. If licensed, the program will contact the License Server
via the internet. It will check-in the license using the License ID
and Password used in Activation. The current computer will
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Step  Action

then become un-activated.

6.12 Options Menu
6.12.1 Options - Basic
6.12.1.1 Changing the COM port

The Basic menu is used to set the COM port to the correct one that the device is connected to. To change the
COM port, perform the following steps:

Step  Action

1 Ensure that the application is running.

%, DevCom2000 - [Explorer] (=
[#] Device Options View Enhanced Trending DD License Window Help =& =
RETP @M
£ 28 Online Item Value ‘ Units

ER=TOverview] & Device Status: Good

e[ Configure ' Comm Status: Burst

3 Service Tools 2 Pressure 21inH20
D fna log Output 11.331 mA
') Upper Range Valu... 40.0 inH20
‘%1 Lower Range Value(4 mA) -30.0 inH20

I Device Information

< | [II} »

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| (Cx Trend Activit NUM

2 Select Options = Basic from the main window. The Options Dialog
Box is displayed with the Basic tab selected:
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Step  Action
Options @1

6

Basic | Search By | Advanced

Modern Server Preferences

Serial Port COmMA4D hd (mvailable)

Online DevComz000

[ Use TCR/IP with WirelessHART Gatewsy

IF Address: ‘ 192 w1 .om Advanced Settings
Port; 2094

[ Use HART Server with WirelessHART Gateway or HART Multiplexer
(Note: HART Server must be purchased from the HART Foundation)

Restore Defaults

To change serial ports, Click on the drop down box:

Serial Port  |COMS1 ~|
COMA43 -

line DevCom20n| COr50 |

COmb2

Use with WirelessHART Gateway or HART hult

Once the desired COM port is selected click OK to save the changed

settings.

Click Yes if you want to save the changes. Clicking No will not save

the changes.

DevCom2000

—  preferences?

i Are you sure you want to save the changes you made to your

h

Select New Device from the Main screen to connect using the new

COM port.
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6.12.1.2 Use HART-IP with a WirelessHART Gateway

The Basic menu is where DevCom2000 can be set to use HART-IP to communicate with a WirelessHART
Gateway. To communicate using HART-IP with WirelessHART Gateway, perform the following steps:

Step  Action

1 Ensure that the application is running.

% DevCom2000 - [Explorer] = | O -
[a'] Device Options View Enhanced Trending DD License Window Help _ & =
RED &

E-& Online Item Value ‘ Units

GM 1% Device Status: Good
(3 Configure @ Comm Status: Burst
(3 Service Toals 1% pressure 21inH20
D Ana og Qutput 11331 mA
' upper Range Valu... 40.0 inH20
% Lower Range Value(4 mA) -30.0 inH20
L1 Device Information
< 1l 3
Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| ) Trend Activit INUM

Select Options = Basic from the main window. The Options Dialog
Box is displayed with the Basic tab selected:

Options ﬁ ]

Basic ISear:h By | Advanced

Modem Server Preferences

Serial Port COmM40 hd (awvailable)

Online DevComz000

[~ Use TCP/IF with WirelessHART Gateway

IP Address | 192 . 168 1 1 Advanced Settings
Part [5094

[T Use HART Server with WirelessHART Gatewsay or HART Multiplexer
(MNote: HART Server must be purchased from the HART Foundation)

OK Cancel Restore Defaults
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Step  Action

3 Click “Use TCP/IP with WirelessHART Gateway”
Options &y

Basic WSearch By | Advanced

Moderm Server Preferences

Serial Port COk40 (Evailable)

Online DevCom2000

[v Use TCPAP with WirelessHART Gateway

IP Address | 192 .88 . il Advanced Settings
Part: (5094

[ Use HART Senverwith WirelessHART Gateway ar HART Multiplexer
(Note: HART Server mustbe purchased from the HART Foundation)

u]s Cancel ‘ Restore Defaults |

The Serial Port option will now be grayed out. Un-checking will
make Serial Port selectable again.

4 Enter the I[P Address of the WirelessHART Gateway in the IP
Address Field. Also enter the Port assigned to HART-IP in the
Gateway. It is typically 5094.

5 For more advanced settings related to HART-IP, click the
“Advanced” button. The following dialog box appears:

Advanced HART-IP Setup S

Gateway Addressing

Gateway LIRL: |

Resaolse |

Enter Gateway LIRL as text then press "Resaolve" to find IP Address

Gateway HART Address: |0

Save | Cancel |

Communicating to a WirelessHART Gateway via its URL
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Step  Action

Enter a URL text address in the URL field and click the “Resolve”
button to convert it into an IP Address. The IP Address will populate

the IP Address box if a successful conversion occurs.

Gateway Address

Some WirelessHART Gateways do not use the default address of 0.
For these Gateways you must enter the correct Gateway Address in
this field.

6.12.1.3 Using HART Server

The Basic menu is used to set DevCom2000 to communicate with a WirelessHART gateway or HART
multiplexer. This requires an external program called HART Server. Although DevCom2000 can use
HART Server for WirelessHART communications, it is recommended that HART-IP be used. To
communicate with a WirelessHART Gateway or a HART multiplexer, perform the following steps:

Step  Action

1 Ensure that the application is running.
% DevCom2000 - [Explorer] | = |E e
[#'] Device Options View Enhanced Trending DD License Window Help - =] =
RTFAE
2-& Online Item Valual Units
ﬂ 1% Device Status: Good
=3 Configure % Comm Status: Burst
(3 Service Tools ' pressure 2.1inH20
& Analog Output 11331 mA
2 upper Range Valu... 40.0 inH20
% Lower Range Value(4 mA) -30.0 inH20
3 Device Information
“ I »
Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03,/07 o HART Activit O Trend Activit NUM
2 Select Options = Basic from the main window. The Options Dialog

Box is displayed with the Basic tab selected:
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Step  Action
Options @1

Basic ISearch By | Advanced

Modem Server Preferences

Serial Port COM40 - (available)

Online DewvComz000

[ Use TCRAR with WirelessHART Gateway

IP Address ‘ 182 16# 1 n Advanced Settings
Part: (5094

[ Use HART Serverwith WirelessHART Gateway or HART Multiplexer
(Mote: HART Server must be purchased from the HART Foundation)

Ok Cancel Festare Defaults

3 Click “Use HART server with WirelessHART Gateway or HART
Multiplexer”
( Options ﬁﬂ

Basic WSearch By | Advanced

Modem Server Freferences

Serial Port COM40 (awvailakle)

Online DevCom2000

[T Use TCR/IP with WirelessHART Gatewsy

IP Address: | 182 1G# 1 " Adhvanced Setings
Port (5034

[v Use HART Server with WirelessHART Gatewsy or HART Multiplexer
(Note: HART Server must be purchased from the HART Foundation)

Ok | Cancel Restore Daefaults

4 The Serial Port option will now be grayed out. Un-checking will
make Serial Port selectable again. Click OK to save the changed
settings.

5 Click Yes if you want to save the changes. Clicking No will not save

the changes.
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Step  Action

DevCom2000 o

i Are you sure you want to save the changes you made to your
preferences?

6 Restart DevCom2000 for the changes to take place.

6.12.3 Options - Search
6.12.3.1 Poll Address
The Search menu is used to change how DevCom2000 searches for a Device. The first option is to search
by Poll Address. This searches for a specific poll address or set of addresses. To search for a device using

Poll Address perform these steps:

Step  Action

1 Ensure that the application is running.
% DevCom2000 - [Explorer] = |5 -
[#'] Device Options View Enhanced Trending DD License Window Help - =] =
RET 2 M
2-& Online Ttem Valuel Units
=loverview] 1 Device Status: Good
=3 Configure % Comm Status: Burst
(3 Service Tools ' pressure 2.1inH20
9 Ana og Output 11331 mA
2 upper Range Valu... 40.0 inH20
% Lower Range Value(4 mA) -30.0 inH20

I3 Device Information

4| m 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03,/07 o HART Activit O Trend Activit NUM

2 Select Options - Search from the main window. The Options
Dialog Box is displayed with the Search By tab selected:
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Step  Action
Options ﬁ

Basic Search By |Advnnced|

Seanch By

Foll Addrass v | Search by Tag

Search by Poll Address
WirelessHART Adaptar - Dafault

@ use poll address 0 onby " ABB Fialdkey-15

( fnd rst poll address
C i pot.acie " Emerzon THUM - 63

e || mcdd &3
e ( EndresssHauser SWATD-15

" search 0-15
" MACTek BULLET -15

" search 031
 saarch 3 (" Pepparl+Fuchs WHAADP - 15
" seasch range: [0 theough |0 Lt
¢ Semens SITRAMS AWZ00-15
Ok, I Cancel | Riestone Defaulis
3 There are currently nine options for Poll address:

e “use poll address 0 only” only searches at poll address 0 before
not finding a device. This is the default setting.

* “find first poll address” searches poll addresses until it finds
the first device it comes across.

e “use poll address:___” If the poll address is know this options
searches at a specific address (i.e. 5).

e “search 0-15” searches poll addresses O through 15.
e “search 0-31” searches poll addresses O through 31.
e “search 0-63” searches poll addresses O through 63

e “searchrange ___ through ___ " searches between a user
identified range of poll addresses.

e “MACTek Bullet — 15” searches poll address 15.
e  “Emerson Process Management THUM - 63” searches poll
address 63.

4 The Search by Tag option is grayed out when searching by poll
address. Select a search by poll address option and Click OK to save
the changed settings.

5 Click Yes if you want to save the changes. Clicking No will not save
the changes.
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Step  Action

=

DevCom2000 o

i Are you sure you want to save the changes you made to your
—  preferences?
Yes No
6 Reconnect to a new device.

6.12.3.2 Short Tag

The Search menu can also be used to search by a specific Tag name or Description. To search for a device
based on a Tag name or a Description, perform the following steps:

Step  Action

1 Ensure that the application is running.
%, DevCom2000 - [Explorer] = | [E] -
[# Device Options View Enhanced Trending DD License Window Help - =] =
RIEE &
=-£8 Online Item Value‘ Units
¥=Toverview] I Device Status: Good
{2 Configure 1 Comm Status: Burst
-3 service Tools [ Pressure 2.1inH20
& Analog Output 11331 mA
& upper Range Valu... 40.0 inH20
‘2 Lower Range Value(4 mA) -30.0 inH20
31 Device Information
< I 3
Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 | @ HART Activit| € Trend Activit NUM
2 Select Options = Search from the main window. The Options
Dialog Box is displayed with the Search By tab selected:
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Step  Action
Options ﬁ ]

Basic Search By IAdvanced 1

Search By

Poll Address + | Search by Tag

Search by Poll Address
WirelessHART Adapter - Default
@® uyse poll address 0 only  ABB Fieldkey-15

(" find first poll address ~ Emerson THUM - 53

B3
® e ertiEes (" Endress+Hauser SWA7TD- 15
(" search 0-15
" MACTek BULLET-15
(" search 0-31
" Pepper+Fuchs WHA-ADF-15
(" search 063
W SO e ,70 ey ,70 " Phoenix Contact BAD-WHA - B3

(" Siemens SITRANS AWw/200-15

0K Cancel | Festore Defaults

3 Select “Short Tag” from the Search By drop down box.

-

Options

Basic  =earch By lAdvanced ]

Search By

|PDIIAddress j Search by Tag
Pall Address

Search by Poll Address

(@ use poll address 0 only

(" find first poll address

4 The poll address options will now be grayed out. Enter the tag to be
searched for in the “Search by Tag” edit box.
Options ﬁ

Basic  Search By | Advanced |

Search By

Short Tag ~ | Searchby Tag |TESTDEY

Search by Foll Address
WirelessHART Adapter - Default

e

I N S i e

o through |0

Q@@ an@ @

Qe Cancel Restore Defaults
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Step  Action

5 Click OK to save the changed settings.

6 Click Yes if you want to save the changes. Clicking No will not save
the changes.
[ DevCom2000 S |

i Are you sure you want to save the changes you made to your
preferences?

7 Reconnect to a new device.

6.12.4 Options > Advanced
6.12.4.1 HART Master

The Advanced menu is used to change DevCom2000 settings. DevCom2000 can be a Primary or
Secondary HART Master. To change the HART Master setting, perform the following steps:

Step  Action

1 Ensure that the application is running.

%, DevCom2000 - [Explorer] =Ey X
[#'] Device Options View Enhanced Trending DD License Window Help — & =
RETEE
=-2 Online Item Value‘ Units

B E\!m 1 Device Status: Good

3 Configure 9 Comm Status: Burst

[ Service Toals & pressure 21inH20

& Ana og Output 11331 mA

' upper Range Valu... 40.0 inH20
121 |ower Range Value(4 mA) -30.0 inH20
11 Device Information

< I 3

Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 Q HART Activit| @ Trend Activit NUM

2 Select Options 2> Advanced from the main window. The Options
Dialog Box is displayed with the Advanced tab selected:
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Step  Action
Options &J ]

Basic | SearchBy Advanced

HART Master DD Startup
(@ Primany @ Device DD
(" Secondarny (" GenericDD
Select Language ®
" *-Change in language will not take effect until
English T | DevCom2000 is restarted.

[ Don't Connectto Device On Startup

QK | Cancel ‘ Festore Defaults

3 Under the section “HART Master” select either “Primary” or
“Secondary”.

4 Click OK to save the changed settings.

Click Yes if you want to save the changes. Clicking no will not save
the changes.

DevCom2000

Are you sure you want to save the changes you made to your
preferences?

6 Restart DevCom2000 for the changes to take place.

6.12.4.2 Language

Certain DD’s can be used in different languages. English is the default setting but some support other
languages. Note that main program frame will always be English. Only the DD based items — menus,
variables, etc. will change language. And will only change if the DD supports that language. In order to
change the Language setting, perform the following steps:

Step  Action

1 Ensure that the application is running.
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Step  Action

%, DevCom2000 - [Explorer] | = [
[#'] Device Options View Enhanced Trending DD License Window Help (= Il & ] x
EIEEIE NN
=--£8 Online l:gem Value [ Units
- am % Device Status: Good
@3 Configure @ Comm Status: Burst
=-(3 Service Tools 1 Pressure 2.1inH20
@ Ana og Output 11331 mA
9 upper Range Valu... 40.0 inH20
% Lower Range Value(4 mA) -30.0 inH20
I3 Device Information
< 1 | 3
Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 | @ HART Activit| &) Trend Activit| |NUM | Y

Select Options = Advanced from the main window. The Options
Dialog Box is displayed with the Advanced tab selected:

I Options $1

Bosic | SearchBy Advanced |

HART Master DD Startup
iw Prmany @ Denice DD
(~ Secondans i~ Genenc DD

Seled Languagea *

English - | *-Change in language will not take affect until

D Com2000 is rostated

[T Don® Connect to Densca On Startup

QK Cancel Festore Defauks

Click the “Select Language” drop down to select a different
language.
Select Language *

Engflish - | - Change in language will nottake effect until
DevComz000 is restarted.
English
French
L On Starup
Italian
Japanese
Spanish
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Step  Action
4 Select a language to translate the DD into. Click Okay to save the
changed settings.
5 Click Yes if you want to save the changes. Clicking no will not save
the changes.
[ DevCom2000 )
Are you sure you want to save the changes you made to your
preferences?
Yes No
6 Restart DevCom2000 for the changes to take place. If the language is
supported the DD will be translated. If not, the DD with default to
English.
6.12.4.3 DD Startup

During normal startup of DevCom?2000, the device is found and then the DD is loaded. If the DD cannot be
found then a generic DD is loaded. Advanced has settings that can change what DD DevCom2000 loads
with loading a device. To load a generic DD at start up or to not load a DD at all perform the following

steps:

Step  Action

1 Ensure that the application is running.

% DevCom2000 - [Explorer]

= |E - |

[#'] Device Options View Enhanced

REI @ BB

Trending DD License Window Help

o

x

= Q_:\ Online
=3
-3 Configure
&~ Service Tools

Tag: P-101 - LongTag/Desc: TEST UNIT

Item

Value‘ Units

% Device Status: Good

' Comm Status: Burst

1 Pressure

@ Ana og Output

9 upper Range Valu...

‘2 Lower Range Value(4 mA)
I3 Device Information

2.1inH20
11.331 mA

40.0 inH20

-30.0 inH20

4 i

- Device: 3051 - DD: 26/06/03/07 o HART Activit @ Trend Activit

NUM
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Step  Action

2 Select Options = Advanced from the main window. The Options

Dialog Box is displayed with the Advanced tab selected:
Options Hh
Bosic | SearchBy Advanced |
HART Master DD Seartup
i Primeny @ Denvice DD
™ Secondany ¢ Genenc DD
Select Language *
m Eﬁ%gn&;;&upg:;g;mﬂll not take effect wnti
[T Dont Connect to Denice On Statup
8] Cancel Festore Delmuls

3 Click either “Device DD” or “Generic DD” depending on which DD
is to be loaded when connecting to a device.

4 Check the “Don’t Connect to Device On Startup” to start
DevCom2000 without connecting to a device. Clicking “New
Device” will connect to a device after this start up.

5 Click OK to save the changed settings.

6 Click Yes if you want to save the changes. Clicking no will not save
the changes.

[ DevCom2000 S |
i Are you sure you want to save the changes you made to your
_ preferences?
Yes No

7 Restart DevCom2000 for the changes to take place.

8 If “Don’t Connect to Device On Startup” is checked the following
message will be displayed on start up:
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—

DevCom2000 ——

& I % Not Connecting to Device. Click 'New Device' to connect.

6.12.4.4 Default Settings

The “Default” button on the Advanced tab Options resets all the advanced options to their default settings.
To return the settings to their default settings perform the following steps:

Step  Action

1 Ensure that the application is running.

% DevCom2000 - [Explorer] = | 5 |l

[®7 Device Options View Enhanced Trending DD License Window Help
REFT S BE

E-&3 Online Ttem Valuel Units
=1 Ooverview] " Device Status: Good
-3 Configure @ Comm Status: Burst
(3 Service Tools [ Pressure 21inH20
1@ Analog Output 11331 mA
@ upper Range Valu... 40.0 inH20
@ Lower Range Value(4 mA) -30.0 inH20

3 Device Information

< | (I} »

[Tag: P-101 - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| (2 Trend Activit NUM

2 Select Options > Advanced from the main window. The Options
Dialog Box is displayed with the Advanced tab selected:
Gptions =]

Basic | Search By Advanced
HART Maszter DD Startup
® Prmany & Device DD
¢ Secondery  Genenc DO

Select Languoge *

*- Change in langusge will not take affect il

Engiis
|Engish T DendCom2000 is restamed

™ Dont Connect o Dendca On Startug

QK Cancel FRestore Delaults
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3 Click the “Restore Defaults” button.
4 DevCom2000 will ask if you want to restore the default settings.
Click “Yes”
f DevCom2000 )

! %, Restore to Default Settings?

5 If the restore was successful the following dialog box will be shown:

DevCom2000 -

l'-\ Settings Restored

6 Click OK to save the changed settings.

7 Click Yes if you want to save the changes. Clicking no will not save
the changes.
DevCom2000
Are you sure you want to save the changes you made to your
preferences?
Yes No
8 Restart DevCom2000 for the changes to take place.

6.13 Trending
6.13.1 Define Trend

The Trending menu is used to track dynamic device parameters over a specified period of time. Once a
parameter is tracked, it can be graphed and compared against other parameters tracked on the same time
period. Before a parameter can be graphed, a trend must first be created. To create a trend, perform the

following steps:
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1 Ensure that the application is running and is connected to a device.
%, DevCom2000 - [Explorer] = | S |-
m '\_ Device Omptions View Enhanced Trendin_g DD License Window He!_p |- =] =
RES(2
E-& Online Item Value‘ Units

ﬁm ' Device Status: Good

(2 Configure ® Comm Status: Burst

(3 Service Tools R pressure 2.1inH20
& Analog Output 11331 mA
' upper Range Valu... 40.0 inH20
) Lower Range Value(4 mA) -30.0 inH20

13 Device Information

< 1 | »

Tag:P-101 - LongTag/Desc: TESTUNIT - Device: 3051 - DD: 26/06/03/07 @ HART Activit| @ Trend Activit]  |[NUM

2 Select Trending = Define Trend from the main window. The
Define Trend Dialog Box is displayed:

Define Trend ﬁ

Select parameters). Maximurm 4. use CNTREL key to select mulitple

Analag Output
Custom Mater Value
Percent of Range
Pressure

Sensor Temparature
Status group 1
Status group 2
Status group 3

Enter Interval: 1 Seconds - I
For how long?

Enter Filename: (saved as a bd fila)

|C.'tUsers‘-ProC0mSOI‘uTESTDE\-" 11104 Brawse

[« Confinuous

Motes;

| Sten | Cancel

N

3 Select the information for the log file:

Select Parameters — Select up to four parameters to log at a time.
Press the CNTRL key to select multiple parameters.

Enter Interval - Input a number and select an interval from the drop
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Step  Action

down box, i.e. Seconds, Minutes, Hours, Days.

For How Long? — Input duration for how long to log the
parameter(s). This part will be grayed out if the “Continuous” check
box is selected. Unselect it for a finite duration.

Filename — The default directory is based on Windows User
Accounts however a log file can be saved anywhere.

Notes — The section can only be 250 characters long.
4 Click the “Start” button to start logging.

The logging will then be started. At the lower right hand corner of
DevCom2000 the “Trend Activity” light will come on. This
indicates that there is logging going on. You cannot start another log
until this one is finished or the user stops the trend manually.

@ HART Activit| @ Trend Activit NUM

6.13.2 View Current Trend

When a trend is created DevCom2000 creates a window that shows the graph of the current trend. To view
this trend, perform the following steps:

Step  Action

1 Ensure that the application is running and is connected to a device.
% DeComaond - [Exploeer] ——
® | Device Optione View Enhanced Treadng DO Licerse Window  Melp
2 FeEB

& O

.|
h

W

273

= Overvie
@ ) Corfgui
& L Sennce

CEEEENI -

i

Ty P-100 - LongTagDeie TEST LINIT Deewiee: 3051 - DO /060307 HART Actren Togfesl ALt LU
Ll

2 Ensure that a trend is in progress. The “Trend Activity” light at the
bottom of the screen is on if a trend is in progress. If not then the
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4

light will be off.

@ HART Activit, @ Trend Activit NUM

Select Trending - View Current Trend from the main window.

The DevCom2000 Trend dialog opens up.

%, Dm0 - [Trending Wavesarmn] = | (2] -
® | Device Options View Entanced Trending DD License ‘Window Help

w - B8 e B e @R

Tag: P-101 LongTag/Desc: TEST UNIT Device: 3051 - DO H50&03,07 0 HART Activit 0 Trend Activit HUM

The user can manipulate the graph as desired. “Tracking” is the
term used to describe how the graph control follows the data,
changing the axis in real time so that all of the data is shown.
Below are the specific parts of the graph:

Tool Bar: There are multiple things that the user can do with the
graph.

Pl & Q& e B [ &R

Resume All Tracking: The “Resume All” button - * - is grayed
out while tracking. If either axis is changed or the “Pause” button

is pressed, this will be come green - g Pressing “Resume All
Tracking” will resume the tracking on the graph.

Pause All Tracking: The “Pause” button - 1l - pauses the graph in

its current state. Data is still added, however the current X-axis and
Y-axis spans no longer change. Pressing the “Resume” button will

continue tracking.

Scroll Axis: This is the default way to scroll both the X and Y-axis.

The “Scroll Axis” button - + allows the user to scroll in both
directions on the graph.
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Zoom Axis: The “Zoom Axis” button - ‘& - allows the user to
shrink or enlarge the scale of either axis. By moving up or down,
left or right, the span of each axis is changed.

Zoom Out All Axis: The “Zoom Out All Axis” button - & -
zooms out both the X-axis and Y-axis at the same time giving the
user a broader look at the graph.

Zoom In All Axis: The “Zoom In All Axis” button - & - zooms in
both the X-axis and Y-axis at the same time giving the user view
over a smaller time period.

allowing the user to select a specific area of the graph to zoom in
on for a more detailed look.

Cursor: The “Cursor” button - ** - adds a cursor to the screen that

gives the coordinates of the graph at a certain time. Clicking and
moving the cursor can give the coordinates of any point on the
graph. See below for an example of using the “Cursor” tool:

Properties: The “Properties” button - - brings up the
“Properties” dialog box which gives the user the ability to
customize the graph as desired. Below is an example of one of the
“Properties” tabs:

Plot e ]
:COI‘ﬂI'Ol | Latyoun | Channels | Cursors | Lirnits: | Labels Frlwas | -Awns | Legenl:l| Tablesi ToolBar | Diata ‘-"IQ‘wl
General |T|=Ie | Background | Print | Hirts | File 110 | Annotstion Dietaults |
Baorder Sty Outer Margin
Copy To ClipBoard Format |Meta File - " None 5 |
=]
File Cal S Tab - - o =
e Column Separator | Tal  Rasiced ls_j 3 j
5 5 =
B " Leweted |
M CipAnnctations ToAxes
Update Frame Rate |60 j ¥ Auto Frame Rale
s
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Copy To Clipboard: The “Copy To Clipboard” button - 5& - copies
the graph to the clipboard to allow the graph to be pasted into
documents like a report.

Save: The “Save” button - I8 - saves the graph as a “*.bmp”.
Print: The “Print” button - & - prints the graph.
Preview: The “Preview” button - L& - gives a print preview of the
graph.
Title: The title gives the name of the parameter being trended, the
units that the parameter is being measured in, and the date(s) of the
graph.

(Parameter) (Units) - (Date)

Axis: The Y-axis is the units of the parameter. The X-axis is the
time in HH:MM:SS format.

Redraw: This section is disabled for View Current Trend.

6.13.3 View Past Trends

DevCom2000 keeps a list of trends that have been done in the past. These trends are saved so that they can be
viewed at a later date. To select a trend to be viewed perform the following steps:

Step  Action

1 Ensure that the application is running, you do not have to be
connected to a device to use View Past Trends.
\, DevCom2000 - fxphoeer] -
® | Device Opoons View Entanced Trending DD License Window Help "
Ik 2 B0
| [ERROR: Faied 1o accuire a device desaiy € HART Acwat ) Trend Actit
2 Select Trending - View Past Trends from the main window.

3 The Select Trend To Graph dialog will open.
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Select Trend to Graph = | E -
| LangTagTese Dienvice | Diate | Stan Tene File | Hotes -
TEST 106744 20130530 15:40:24 11 s . =
TEST 1106744 20130330 154451
TEST 106744 0130330 155778
TEST 1106744 2013-05-30 164239
VEFRSFY DESC EELRER ] 201310-1 101208
VEFFY DESC 342378 2013-10-0 10:15:48
7451130 201310-01 10:31:31 -
Device Tag | Browse
r Parameters Logged
Long TagOescripbon Pasamiher 1
Pasamatar 2
Durvice Pacarnéber 3
Faramebor 4
Ee Name: I
Date:
Start Time
Motas

== "Notes” secton cannod be lenger than 750 charactars ™

Goph | Tet | Dowe Close

This dialog box is very similar to the “Download/View” dialog
box.

Data: Opens the text file where the data has been saved.

Delete: Deletes a previous trend from the database.

Close: Closes the dialog box.

Trend: Opens the saved Trend and displays it graphically. Select a
trend to graph and click “Trend”.

4 The DevCom2000 Trend dialog opens up when “Trend” is
selected.

Pl [+4 @& T B BESR l

13:30:00 13:40:00 1350:00 14:00:00 14:10:00

¥ PiessuieinH20 I™ Graph 2

I~ Graph2 I” Graph 4 Re-Draw

The user can manipulate the graph as desired. “Tracking” is the
term used to describe how the graph control follows the data,
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changing the axis in real time so that all of the data is shown.
Below are the specific parts of the graph:

Tool Bar: There are multiple things that the user can do with the
graph.

Pl e Q& [k BESR

Resume All Tracking: The “Resume All” button - * - is grayed
out while tracking. If either axis is changed or the “Pause” button
is pressed, this will be come green - e Pressing “Resume All
Tracking” will resume the tracking on the graph.

Pause All Tracking: The “Pause” button - I - pauses the graph in
its current state. Data is still added, however the current X-axis
and Y-axis spans no longer change. Pressing the “Resume” button
will continue tracking.

Scroll Axis: This is the default way to scroll both the X and Y-

axis. The “Scroll Axis” button - + allows the user to scroll in
both directions on the graph.

Zoom Axis: The “Zoom Axis” button - ‘R - allows the user to
shrink or enlarge the scale of either axis. By moving up or down,
left or right, the span of each axis is changed.

Zoom Out All Axis: The “Zoom Out All Axis” button - S -
zooms out both the X-axis and Y-axis at the same time giving the
user a broader look at the graph.

Zoom In All Axis: The “Zoom In All Axis” button - & - zooms
in both the X-axis and Y-axis at the same time giving the user
view over a smaller time period.

allowing the user to select a specific area of the graph to zoom in
on for a more detailed look.

Cursor: The “Cursor” button - M adds a cursor to the screen that

gives the coordinates of the graph at a certain time. Clicking and
moving the cursor can give the coordinates of any point on the
graph. See below for an example of using the “Cursor” tool:
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Properties: The “Properties” button - - brings up the
“Properties” dialog box which gives the user the ability to
customize the graph as desired. Below is an example of one of the
“Properties” tabs:

[ piot S

[Conirol | Layut | Channets | Cursors | Limits | Labals | X-axes | v-Awes | Legend | Tables | ToolBar | Date view |

General |T|!|Q | Background | Print | Hints | Fila 70 | Annotation Detauls |

Border Style Outer Margin
Copy To ClipBoard Format |Meta File - ™ None 5 |
=1
File Column Separator | Tab - - | |
" Rased 5 1 5 =
5 iy |

3 Lowesrad
¥ Cip Annotations To Aues =l

Update Frame Piate |E0 jll ¥ futoFrame Rale

.

Copy To Clipboard: The “Copy To Clipboard” button - 5&! -
copies the graph to the clipboard to allow the graph to be pasted
into documents like a report.

Save: The “Save” button - & - saves the graph as a “*.bmp”.
Print: The “Print” button - = prints the graph.

Preview: The “Preview” button - L& - gives a print preview of the
graph.

Title: The title gives the name of the parameter being trended, the

units that the parameter is being measured in, and the date(s) of
the graph.

(Parameter) (Units) - (Date)

Axis: The Y-axis is the units of the parameter. The X-axis is the
time in HH:MM:SS format.
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Redraw: Up to four parameters can be trended at the same time.
By clicking the check box for a parameter u can show one or four
at the same time for easy comparison over a period of time.

¥ Pressure inH20 [ Graph 3
[T Graph 2 [ Graph 4

Click “Redraw” and the parameters checked will be shown.

6.13.4 Stop Current Trend
Step  Action

1 Ensure that the application is running and is connected to a device.
Y, DevComond - [Explover] ——
® ' Device Option: View Enhanced Tresdng DO Licerse Window  Help
-] FaEd

O Ordne hem Viahue

o o Owervew = D

@ O Cortgus o

% 53 Lervice Took .
ot
- 2.8 T
4: B8 I

T 101 - LongTag/Dete TEST UNIT - Dewite: 3061 - DO: M0G8T ©) HART Anret| ) TeendAetwtl WM

2 Ensure that a trend is in progress. The “Trend Activity” light at the
bottom of the screen is on if a trend is in progress. If not then the
light will be off.

@ HART Activit, @ Trend Activit NUM

Select Trending - Stop Current Trend from the main window.

4 You will be asked if you want to stop the current trend. Click
“Yes”. This will stop the current trend.
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DevCom2000 [ I

9 Do you want to stop the current Trend in progress?

Yes MNo

5 The “Trend Activity” light will now be off.

(T3 HART Activit| () Trend Activit NUN

6.14 DD Functions
6.14.1 Adding a DD

DevCom2000 allows the user to add a DD to the library when necessary. Each DD must be in its appropriate
destination for DevCom2000 to find the DD. The format is: “C:\HCF\DDL\Library\xxxxxx\yyyy\” where
“xxxxxx’’ represents the manufacturer ID and “yyyy” represents the device ID. The user does not need to add
the directory structure, DevCom2000 does that automatically. To add a DD perform the following steps:

Step  Action

1 Ensure that the application is running, you do not have to be
connected to a device to use Add DD.
Y, DevComa000 - [Explorer] 5
& | Device Opocns View Enfanced Trending DD License Window Help
aAlessEn
Irem Wabue | Units
LEP.P.GR Faibad 16 BOCUne & SEVie ety ) HART Actwit € Trend Actiat ML

2 Select DD = Add DD from the main window.
The Add DD dialog will open.
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[ Add DD =)

Enter Location of File: Browse |
OO Info )
Device Lahel:
hanufacturer Mo: —
Dewvice Mo —_—
Device Rew: —_—
OO Rew: —_—
Type —_—
Add DD ‘ IUpdate Lakel ‘ Cloge ‘
4 Click “Browse” and go to the location of the DD that is to be added.

The “DD Info” section will be populated. Confirm that it is the
correct DD. Below is an example of 0000c2/0021/0201.fm6:

— DD Info
b arufacturer Mo: 00002
Device Ma: 0021
Device Rew: 0z
DD Rew: o1
Type = fmb

6 Input a “Label” for the DD if necessary. If not Click “Add DD” to
add the DD to the library.

6.14.2 Updating a DD Label

DevCom2000 allows the user to add a Label for a DD if there is not one already defined. Below is an
example:
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Ela DD Library = | | DD-Revision
-] Standard [0=00)
E- Armetek (0203

-1 Erooks Instrument [D:04)
E-_ Dariel Industries [0x00]
-1 Endress & Hauser [0211)
- ABE [0x12)

[=B| Fizhier Cantrals [0x13)
-] Pasition =mitter [0x00)
B (0402)

-] DWCEDOO [0x03)
- [0x04)
-] DWC2000 [0x05)
- [0x07)

+-{_] Fowbaro [0x14)

o1 Fuiji [0x15)

H-_ ] ABE [0x1E)

t-_ 1 Honeywell [0x17) =
< | 3| | | |

The manufacturer ID of Fisher Controls is 000013. Device IDs 0002, 0004, and 0007 all do not have a
label. This is when updating a DD label is useful. To update the label perform the following steps:

Step  Action

1 Ensure that the application is running, you do not have to be
connected to a device to use Add DD.
& DevCom2000 - [Explorer] = | [E] |-
[#] Deviee Options View Enhanced Trending DD License Window Help - e =
RE&@RA
Item Value | Units |
ERROR: Failed to acquire a device identity. © HART Activit] Cr Trend Activit NUM

2 Select DD - Add DD from the main window.
3 The Add DD dialog will open.
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[ Add DD =)

Enter Location of File: Browse |
DD Info
Device Label:
Manufacturer Mo; —_—
Cevice Mo: —_—
Device Rew: —
DD Rew: —_—
Type —
Add DD ‘ Updats Label ‘ Closs |
4 Click “Browse” and go to the location of the DD that is to have the
label updated.
5 The “DD Info” section will be populated. Confirm that it is the
correct DD. Below is an example of 0000c2/0021/0201.fm6:
— DD Info
M arufacturer Mo: 00002
Device Mo: 01
Device Rew: 02
DD Rew: |
Type * fmb

6 Input a “Label” for the DD if necessary. Click “Update Label” to
update the label.

7 Below is the new “Available DDs” sections where 000013/0002 is
given the label “Updated Label”:

=
-3 DD Library = DD-Revision
-] Standard [0=00)
= L Ametek [0=03)

-1 Brooks Instrument [Ox0a]
- Darniel Industries [0=00]
-1 Endress & Hauser [0x11]
E=-_0 ABE [0x12)
[Efs] Ficher Contrals [0« 3)
G- Position Xmitter [0=00]

#-_J Updated Label [0:02)
& DWCEDOO (003
E- (0404)
- D%C2000 [0x05)
-0 [0x07)

f-|_1 Foxboro [Ox14)

7 _ 71 Fuiji (0=15)

w1 ABB [0x1E)

f-_ 1 Honepwell [0217) —
<] | 3| <] | |

Our Quality Management System is
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6.15 HART-IP Communication
Step  Action

1

3

Ensure that settings for HART-IP have been made in the Options-
>Basic menu. Note that a HART Modem is NOT required, only
Ethernet access to the WirelessHART Gateway.

Click on “New Device” icon to start the connection process. The
following screen will appear.

[»] Device Options Wiew Enhanced Trending DD License Window Help
B e @ |

WirelessHART MNetwork Dewvice Selection

Status:

Click "Quick Scan" to display all devices in Metwork

Click "Detailed Scan" to displayw all devices in MNetwork Heirarchy
MNote: WWill be significantly slower than Quiclk Scan

Double Click on desired dewvice abowe for canfiguration details

i Quick Scan Detailed Scan Close

Click on “Quick Scan” to provide a simple list of all the devices on the
WirelessHART network. Below is a sample screen:
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™ Device Options View Enhanced Trending DD License Window Help
R T
WirelessHART MNetwork Dewvice Selection
EI~|E| wihartgw
- & 3144 ON THLUIRA
@ BULLET WWITH 3085
8 HAMMOWER MESSE 2013
-8 MODEMTEST
& THURMWITH 3144
B “WIRELESS 648
Status 0=0.13=074=0.84=0
Click "Cuick Scan" to display all devices in MNetwork
Click "Detailed Scan" to display all devices in MNetwork Heirarchy
Mote: Will be significanthy slower than Quick Scan
Diouble Click on desired dewvice abowe for configuration details
Dietailed Scan Close
. . . 9’y . . . .
4 Click on “Detailed Scan” to display all the devices as a heirarchy. This

will show what transmitters are connected to each WirelessHART

adapter. Note that this listing takes significantly longer to generate than

the Quick Scan. Below is a sample screen.

[ Device Options

View Enhanced Trending DD License Window Help
g e T a

WirelessHART Metwork Device Selection

= I wihartopw
2 @ BULLET “/ITH 3095
B HANNOVER MESSE 2013
8 MODEM TEST
B @ THUMWITH 3144
B 31449 0N THUM
- @ WIRELESS 648

Status: |[0=0.13=0.74=0.84=0

Click "CQluick Scan" to display all devices in MNetwork

Click "Detailed Scan" to display all devices in Network Heirarchy
Mote: Will be significantly slower than Quick Scan

Double Click on desired dewvice abowe for configuration details

Quick Scan ‘Detailed Scan | Close
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For both types of list displays, the following icons are used:
HART-IP Icons

‘8 = Gateway
Adapter, WirelessHART
Transmitter

2
g

5 Once a device list has been created, double click on the desired device
to configure/review using DevCom2000. Below is a sample screen:

% DevCom2000 - [Explorer]

[ Device Options View Enhanced Trending DD License Window Help

RETD @ BB

[Ehy=:}

E

E

Online
(3 Overview
#-(1 Device Information
3 Configure
=~ Guided Setup
[ Basic Setup
(3 Configure Display
=~ Manual Setup
&3 Process Variables
-1 Analog Output
(2 Display
-~ HART
2 Security
=~ Device Information
(3 Identification
~-(1 Flange
(3 Remote Seal
(3 Service Tools
3 Alerts
(2 Variables
-1 Trends
(2 Maintenance
-2 Simuilata

+ |Item Value | Units ‘
2 Pressure Units inH20
2 pamping 0.80 sec
' Transfer Function Linear
" Sensor Temperature Units degF
21 pressure -0.6 inH20
1 Sensor Temperature 70.8 degF

nl

Tag:‘P—lDl - LongTag/Desc: TEST UNIT - Device: 3051 - DD: 26/06/03/07

@ HART Activit| (3 Trend Activit NUM

6 To switch to a different device on the WirelessHART network: Select
Window on the MENU bar, then click on HART-IP Device Selection
to bring up the Device Menu Tree again.

g DD License | Window | Help

Cascade
Tile

1 Explorer

v | 2 HART-IP Device Selection
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Appendix A

Troubleshooting Guide

For most error messages, there is a selection for “Com Troubleshooter”. This program will guide you through the
steps to solve your communication problems. Below is a quick summary:

Problem:
Will not communicate

Hardware Check:

Verify the following:

1. Com port number on Preferences Dialog box matches HART interface hardware.

2. Loop power supply is on.

3. Loop resistance between 250 ohms and 1Kohms.

4. Loop current within HART limits.

5. If multi drop configuration, all transmitters in loop have unique addresses.

6. HART interface hardware connected across loop resistor or across transmitter terminals.

Software Check:
Sometimes the application does not end cleanly and the communication process is still running in an unknown state.
When this happens, it must be closed out before restarting DevCom2000.

Perform the following:

1. Close DevCom?2000.

2. Press CTRL-ALT-DEL to bring up the Windows Security Screen.
3. Click on Task Manager.

4. Select the Processes tab.

5. In the list of running tasks, select HModemSvr.exe.

6. Click on the End Process button on the dialog box.

7. Restart DevCom2000.

Problem:
Get the message “Error opening COMx”

Verify the following:
1. Com port number on Preferences Dialog box matches HART interface hardware.
2. HART interface hardware installed.
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Problem:
No data in the Communication Log

Verify the following:
1. Verify that the “HART Activity” LED indicator on the bottom of the screen is flashing red. If not, open a menu
that has dynamic data that is being refreshed like PV or AO.
2. For Windows Vista and Windows 7 users, you may need to perform the following:
a) Open the “hosts” file using Notepad. It is located in the following directory:
C:A\WINDOWS\system32\drivers\etc\hosts
b) Make sure this line appears (without preceding # character)
127.0.0.1  localhost
¢) Make sure the following line does NOT appear:
21 localhost
If it 1s there, comment it out by placing # character in front like this:
#::1 localhost
d) Restart the Communication logger.

Note: To modify this file, you may need to perform the following in Windows:
a) Go to Control Panel->Folder Options

b) Select the View tab

¢) Remove the check next to Hide extensions for known file types

d) Make the edit changes above

e) Save the document to your documents

f) copy the saved document to the above directory

g) Delete the original hosts file

h) remove the .txt extension from the new hosts file

3. Turn off firewall protection temporarily to see if it is blocking the TCP/IP communications between
DevCom2000 and the Communication Logger.

Problem:
The system cannot find the path specified error box

Try the following:
1. Verify that the device library (C:\HCF\DDL\Library) is on Drive C:
2. If not, copy to drive C.

Problem:
Activation by Internet blocked by Firewall

Try the following:

1. Allow one time access to internet via your computer’s Firewall settings.
2. Disable Firewall.

3. Use manual activation method.
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Problem:
Active Windows not shown in Windows drop down list

Try the following:
1. Select Window->Cascade or Window->Tile.
2. All Windows will now be shown

Problem:
When using HART Server for WirelessHART in Windows 7, the device selection screen does not appear

Try the following:

1. Start Windows Explorer.

2. Go to directory "C:\Program Files\ProComSol\Common"
3. Run "RegisterSELECT.bat" as an Administrator
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Appendix B

Contact Information

ProComSol, Ltd

Process Communications Solutions
13001 Athens Ave

Suite 220

Lakewood, OH 44107

USA

Phone: 216.221.1550

Fax: 216.221.1554

Email: sales@procomsol.com
support@procomsol.com

Web: www.procomsol.com
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